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STUDY OF BASICS IN ANSYS 
 

ExNo : 01 

Date : 

Aim: 

To study about the basic procedure to perform the analysis in ANSYS. 
 

Performing a Typical ANSYS Analysis: 

 
The ANSYS program has many finite element analysis capabilities, ranging from a simple, 

linear, static analysis to a complex, nonlinear, transient dynamic analysis. The analysis guide 
manuals in the ANSYS documentation set describe specific procedures for performing analyses for 
different engineering disciplines. The next few sections of this chapter cover general steps that are 
common to most analyses. 

A typical ANSYS analysis has three distinct steps: 

 Build themodel. 

 Apply loads and obtain thesolution. 

 Review theresults. 

Build the model: 
 

1. Defining theJobname: 

The jobname is a name that identifies the ANSYS job. When you define a jobname for an 
analysis, the jobname becomes the first part of the name of all files the analysis creates. (The 
extension or suffix for these files' names is a file identifier such as .DB.) By using a jobname for 
each analysis, you ensure that no files are overwritten. 

 

2. Defining an AnalysisTitle: 

The TITLE command (Utility Menu> File> Change Title), defines a title for the analysis. 
ANSYS includes the title on all graphics displays and on the solution output. You can issue the 
/STITLE command to add subtitles; these will appear in the output, but not in graphics displays. 

 

3. DefiningUnits: 

The ANSYS program does not assume a system of units for your analysis. Except in 
magnetic field analyses, you can use any system of units so long as you make sure that you use 
that system for all the data you enter. (Units must be consistent for all inputdata.) 

 

4. Defining ElementTypes: 

The ANSYS element library contains more than 150 different element types. Each element 
type has a unique number and a prefix that identifies the element category: BEAM4, PLANE77, 
SOLID96, etc. The following element categories are available: 

BEAM MESH 

CIRCUIT Multi-PointConstraint 

COMBINATION PIPE 
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CONTACT PLANE 

FLUID PRETS (Pretension) 

HF(High Frequency) SHELL 

HYPERELASTIC SOLID 

INFINITE SOURCE 

INTERFACE SURFACE 

LINK TARGET 

MASS TRANSDUCER 

MATRIX USER 

VISCOELASTIC (or viscoplastic) 

The element type determines, among other things: 


The degree-of-freedom set (which in turn implies the discipline - structural, thermal, magnetic, 

electric, quadrilateral, brick, etc.) 


Whether the element lies in 2-D or 3-D space. 
 

 

5. Defining Element RealConstants: 

Element real constants are properties that depend on the element type, such as cross- 
sectional properties of a beam element. For example, real constants for BEAM3, the 2-D beam 
element, are area (AREA), moment of inertia (IZZ), height (HEIGHT), shear deflection constant  
(SHEARZ), initial strain (ISTRN), and added mass per unit length (ADDMAS). Not all element 
types require real constants, and different elements of the same type may have different real 
constant values. 

 
6. Defining MaterialProperties: 

Most element types require material properties. Depending on the application, material 
properties can be linear (see Linear Material Properties) or nonlinear (see Nonlinear Material 
Properties). 

As with element types and real constants, each set of material properties has a material 
reference number. The table of material reference numbers versus material property sets is called 
the material table. Within one analysis, you may have multiple material property sets (to 
correspond with multiple materials used in the model). ANSYS identifies each set with a unique 
reference number. 

 
7. Creating the ModelGeometry: 

Once you have defined material properties, the next step in an analysis is generating a finite 
element model - nodes and elements - that adequately describes the model geometry. The graphic 
below shows some sample finite element models. 

There are two methods to create the finite element model: solid modeling and direct 
generation. With solid modeling, you describe the geometric shape of your model, then instruct the 
ANSYS program to automatically mesh the geometry with nodes and elements. You can control 
the size and shape in the elements that the program creates. With direct generation, you "manually" 
define the location of each node and the connectivity of each element. Severalconvenience 
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operations, such as copying patterns of existing nodes and elements, symmetry reflection, etc. are 
available. 

 

 

 

 

 

Sample Finite Element Models 

Apply Loads and Obtain the Solution: 

In this step, you use the SOLUTION processor to define the analysis type and analysis 
options, apply loads, specify load step options, and initiate the finite element solution. You also 
can apply loads using the PREP7preprocessor. 

 

1. Defining the Analysis Type and AnalysisOptions: 

You choose the analysis type based on the loading conditions and the response you wish to 
calculate. For example, if natural frequencies and mode shapes are to be calculated, you would 
choose a modal analysis. You can perform the following analysis types in the ANSYS program: 
static (or steady-state), transient, harmonic, modal, spectrum, buckling, and substructuring. 

Not all analysis types are valid for all disciplines. Modal analysis, for example, is not valid 
for a thermal model. The analysis guide manuals in the ANSYS documentation set describe the 
analysis types available for each discipline and the procedures to do those analyses. 

Analysis options allow you to customize the analysis type. Typical analysis options are the 
method of solution, stress stiffening on or off, and Newton-Raphson options. 
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2. ApplyingLoads: 

 
The word loads as used in ANSYS documentation includes boundary conditions (constraints, 

supports, or boundary field specifications) as well as other externally and internally applied loads. 

Loads in the ANSYS program are divided into six categories: 
  DOFConstraints

  Forces

  SurfaceLoads

  BodyLoads

  InertiaLoads

  Coupled-field Loads

You can apply most of these loads either on the solid model (keypoints, lines, and areas) or 
the finite element model (nodes and elements). 

 
3. Specifying Load StepOptions: 

Load step options are options that you can change from load step to load step, such as 
number of substeps, time at the end of a load step, and output controls. Depending on the type of 
analysis you are doing, load step options may or may not be required. The analysis procedures in 
the analysis guide manuals describe the appropriate load step options as necessary. 

 

4. Initiating theSolution: 

To initiate solution calculations, use either of the following: 

Command(s): SOLVE 

GUI: 
Main Menu> Solution> Solve> Current LS 
Main Menu> Solution>solution_method 

When you issue this command, the ANSYS program takes model and loading information from 
the database and calculates the results. Results are written to the results file (Jobname.RST, 
Jobname.RTH, Jobname.RMG, or Jobname.RFL) and also to the database. The only difference is 
that only one set of results can reside in the database at one time, while you can write all sets of 
results (for all substeps) to the resultsfile. 

 
Review the Results: 

 
Once the solution has been calculated, you can use the ANSYS postprocessors to review 

the results. Two postprocessors are available: POST1 andPOST26. 

You use POST1, the general postprocessor, to review results at one substep (time step) over the 
entire model or selected portion of the model. The command to enter POST1 is /POST1 (Main 
Menu> General Postproc), valid only at the Begin level. You can obtain contour displays, 
deformed shapes, and tabular listings to review and interpret the results of the analysis. POST1 
offers many other capabilities, including error estimation, load case combinations, calculations 
among results data, and pathoperations. 

You use POST26, the time history postprocessor, to review results at specific points in the 
model over all time steps. The command to enter POST26 is /POST26 (Main Menu> TimeHist 
Postpro), valid only at the Begin level. You can obtain graph plots of results data versus time (or 
frequency) and tabular listings. Other POST26 capabilities include arithmetic calculations and 
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Result: 
Thus the basic steps to perform the analysis in ANSYS like 



 Build themodel. 
 Apply loads and obtain thesolution. 
 Review the results. 

arestudied. 
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STRESS ANALYSIS OF A PLATE WITH CIRCULAR HOLE 
 

ExNo : 02 

Date : 

AIM 

To conduct the stress analysis in a plate with a circular hole using ANSYS software. 

 
SYSTEM CONFIGURATION 

 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 

PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 

1. Preference - Structural- h-Method -Ok. 

 

2. Preprocessor - Element type - Add/Edit/Delete – Add – Solid, 8 node 82 – Ok –Option 

– Choose Plane stress w/thk - Close. 

 

3. Real constants - Add/Edit/Delete – Add – Ok – THK 0.5 – Ok -Close. 

 
4. Material props - Material Models – Structural – Linear – Elastic – Isotropic - EX2e5, 

PRXY 0.3 -Ok. 

 
5. Modeling – Create – Areas – Rectangle - by 2 corner - X=0, Y=0, Width=100, 

Height=50 - Ok. Circle - Solid circle - X=50, Y=25, Radius=10 - Ok. Operate – 
Booleans – Subtract – Areas - Select the larger area (rectangle) – Ok – Ok -Select 
Circle – Next –Ok -Ok. 

6. Meshing - Mesh Tool – Area – Set - Select the object – Ok - Element edge length2/3/4/5 

– Ok - Mesh Tool -Select TRI or QUAD - Free/Mapped – Mesh - Select the object - Ok 
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SOLUTION 

 
7. Solution – Define Loads – Apply – Structural – Displacement - On lines -Select 
the boundary where is going to be arrested – Ok - All DOF -Ok. 

Pressure - On lines - Select the load applying area – Ok - Load PRES valve = 1 N/mm2- 
Ok. 

 

8. Solve – Current LS – Ok – Solution is done –Close. 

 
Young’s Modulus = 200 GPa 

Poisson’s Ratio = 0.3 
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RESULT 

Thus the stress analysis of rectangular plate with a circular hole is done by using 
the ANSYS Software. 
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STRESS ANALYSIS OF RECTANGULAR L BRACKET 
 

Ex No: 03 

Date:  
 

AIM 

To conduct the stress analysis of a rectangular L section bracket using ANSYS software 
 

SYSTEM CONFIGURATION 

 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 

PROCEDURE 
 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

PREPROCESSING 

1. Preference - Structural- h-Method -Ok. 
 

2. Preprocessor - Element type - Add/Edit/Delete – Add – Solid, 8 node 82 – Ok –Option 

– Choose Planestress w/thk - Close. 

 

3. Real constants - Add/Edit/Delete – Add – Ok – THK 0.5 – Ok -Close. 

 

4. Material props - Material Models – Structural – Linear – Elastic – Isotropic - EX2e5, 
PRXY 0.3 -Ok. 

 
5. Modeling – Create – Key points - In active CS – enter the key point number and X, Y, Z 
location for 6 key points to form the rectangular L-bracket. Lines – lines - Straight line - 
Connect all key points to form as lines. Areas – Arbitrary - by lines - Select all lines -ok. 

Lines - Line fillet - Select the two lines where the fillet is going to be formed – Ok – enter 
the Fillet radius=10- Ok. Areas – Arbitrary - through KPs - Select the key points of the 
fillet - Ok. Operate – Booleans – Add – Areas - Select the areas to be add (L Shape & fillet 
area) - ok. Create – Areas – Circle - Solid circle - Enter the co-ordinates, radius of the 
circles at the two ends(semicircles) -Ok. Operate – Booleans – Add – Areas - Select the 
areas to be add (L Shape & two circles) - Ok. Create – Areas – Circle - Solid circle – Enter 
thecoordinates,radiusofthetwocircleswhicharementionedasholes-Ok.Operate– 
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Booleans – Subtract – Areas - Select the area of rectangle – Ok - Select the two circles - 
Ok. 

5. Meshing - Mesh Tool – Area – Set - Select the object – Ok - Element edge length 
2/3/4/5 – Ok - Mesh Tool -Select TRI or QUAD - Free/Mapped – Mesh - Select the 
object -Ok. 

 

SOLUTION 

 
6. Solution – Define Loads – Apply – Structural – Displacement - On lines - Select the 

boundary where is goingto be arrested – Ok - All DOF - Ok.Pressure - On lines - Select 
the load applying area – Ok - Load PRES valve = -10000 N (- Sign indicates 
thedirection of the force i.e. downwards) –Ok. 

 

8. Solve – Current LS – Ok – Solution is done –Close. 

 
POST PROCESSING 

 
9. General post proc - Plot Result - Contour plot - Nodal Solution – Stress - Vonmises 
stress -Ok. 

 

TO VIEW THE ANIMATION 

 

10. Plot control – Animates - Mode Shape – Stress - Von mises -Ok. 

 
11. Plot control – Animate - Save Animation - Select the proper location to save the file(E 
drive-user) -Ok. 

 

FOR REPORT GENERATION 

 

12. File – Report Generator – Choose Append – OK – Image Capture – Ok -Close. 
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RESULT 

Thus the stress analysis of rectangular L section bracket is done by using the ANSYS 
Software. 
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Ex No : 04 

Date :  

STRESS ANALYSIS OF BEAM 

 

AIM 

To conduct the stress analysis in a beam using ANSYS software. 
 

 

SYSTEM CONFIGURATION 
 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 
Software: ANSYS(Version12.0/12.1) 

 
PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 
 

1. Preference - Structural- h-Method -Ok. 

 
2. Preprocessor - Element type - Add/Edit/Delete – Add – Beam, 2D elastic 3 – Ok – Options – 
Ok -Close. 

 
3. Sections – beam – Common sections – Select the correct section of the beam and input the 
of “w1, w2,w3” and “t1, t2, t3” – Preview – Note down the values of area,Iyy. 

 
4. Real constants - Add/Edit/Delete – Add – Ok – Enter the values of area=5500, 
Izz=0.133e8, height=3 – Ok-Close. 

 
5. Material props - Material Models – Structural – Linear – Elastic – Isotropic - EX2e5, 
PRXY 0.3 -Ok. 

 
6. Modeling–Create–Keypoints–InactiveCS–EnterthevaluesofCSofeachkeypoints 

– Apply – Ok. Lines – Lines – Straight line – Pick the all points – Ok. 

 
7. Meshing – Mesh attributes – All lines – Ok. Meshing – Size cntrls – Manual size – 

Lines–Alllines–Enterthevalueofelementedgelength[or]Numberofelement 
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divisions – Ok. Mesh tool – Mesh – Pick all. 

 
8. Meshing – Mesh attributes – All lines – Ok. Meshing – Size contrls – Manual size – 

Lines – All lines – Enter the value of element edge length [or] Number of element 
divisions – Ok. Mesh tool – Mesh – Pickall. 

 

SOLUTION 

 

9. Solution – Define Loads – Apply – Structural – Displacement - On key points – Select 
the 1st key point – ALL DOF – Ok. On key points – select the 2nd key point– UY – 
Ok. Force/Moment – On key points – Select the key point – Ok – direction of 
force/moment FY, Value = -1,000 (- sign indicates the direction of the force) –Ok. 

 

10. Solve – Current LS – Ok – Solution is done –Close. 

 
POST PROCESSING 

 
11.  . General post proc – Element table – Define table – Add – By sequence num – 

SMISC,6 – Ok – SMISC,12 –Ok – LS,2 – Ok – LS,3 - Ok – Close. Plot results – 
Contour plot – Nodal solution – DOF solution – Y component of displacement – Ok. 
Contour plot – Line element Res – Node I SMIS 6, Node J SMIS 12 – Ok. Contourplot 

– Line element Res – Node I LS 2, Node J LS 3 – Ok 

FOR REPORT GENERATION 

12. . File – Report Generator – Choose Append – OK – Image Capture – Ok -Close. 
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RESULT 
 

Thus the stress analysis of a BEAM is done by using the ANSYS Software 
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Ex No : 05 

Date :  

MODE FREQUENCY ANALYSIS OF BEAM 

 

AIM 

To conduct the Mode frequency analysis of beam using ANSYS software. 
 

SYSTEM CONFIGURATION 
 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operating system: Window XP Service Pack 3 

Software: ANSYS (Version12.0/12.1) 

 

PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 
1. Preprocessor - Element type - Add/Edit/Delete – Add – Beam, 2D elastic 3 – Ok– 
Close. 

2. Real constants - Add/Edit/Delete – Add – Ok – Area 0.1e-3, Izz 0.833e-9, Height 0.01– 
Ok –Close. 

3. Material props - Material Models –Structural – Linear – Elastic - Isotropic – EX206e9, 
PRXY 0.25 – Ok –Density – DENS 7830 –Ok. 

4. Modeling –Create–Keypoints–InactiveCS–Enterthecoordinatevalues-Ok.Lines 

-lines – Straight Line – Join the two key points – Ok. 

5. Meshing – Size Cntrls – manual size – lines – all lines – Enter the value of no ofelement 
divisions 25 – Ok. Mesh – Lines – Select the line –Ok. 

 

SOLUTION 

 
6. Solution – Define Loads – Apply – Structural – Displacement - On nodes – Select the 

node point –Ok – All DOF – Ok. Analysis type – New analysis – Modal – Ok. Analysis 
type – Analysis options – Block Lanczos – enter the value no of modes to extract as 3 
or 4 or 5 – Ok – End Frequency 10000 –Ok. 

7. Solve – Current LS – Ok – Solution is done –Close. 
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POST PROCESSING 

8. General post proc – Read results – First set - Plot results – Deformed shape – Choose 
Def+undeformed – Ok.Read results – Next set - Plot results – Deformed shape – 
Choose Def+undeformed – Ok and so on. 

 

FOR REPORT GENERATION 

 
9. File – Report Generator – Choose Append – OK – Image Capture – Ok - Close. (Capture 

allimages) 
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RESULT 

Thus the mode frequency analysis of a beam is done by using the ANSYS Software. 

PLUS.CO 
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Ex No : 06 

Date :  

HARMONIC ANALYSIS OF A 2D COMPONENT 

 

AIM 

To conduct the harmonic analysis of a 2D component by using ANSYS software. 
 

SYSTEM CONFIGURATION 

 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 
PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 
 

PREPROCESSING 

 

1. Preprocessor - Element type - Add/Edit/Delete – Add – Beam, 2D elastic 3 – Ok –Close. 

 

2. Real constants - Add/Edit/Delete – Add – Ok – Area 0.1e-3, Izz 0.833e-9, Height 0.01 –Ok 

– Close. 

3. Material props - Material Models –Structural – Linear – Elastic - Isotropic – EX206e9, 
PRXY 0.25 – Ok –Density – DENS 7830 –Ok. 

4. Modeling – Create – Key points – Inactive CS – Enter the coordinate values - Ok. Lines– 
lines – Straight Line – Join the two key points –Ok. 

5. Meshing – Size Cntrls – manual size – lines – all lines – Enter the value of no ofelement 
divisions 25 – Ok.Mesh – Lines – Select the line –Ok. 

 
SOLUTION 

 
6. Solution - Analysis type – New analysis – Harmonic – Ok. Analysis type – Analysis 
options – Full, Real+ imaginary – Ok– Use the default settings –Ok 

 
7. Solution – Define Loads – Apply – Structural – Displacement - On nodes – Select the 
node point –Ok – All DOF – Ok. Force/Moment – On Nodes – select the node 2 – Ok – 
Direction of force/mom FY, Real part of force/mom -100 – Ok. Load step Opts– 



17  

Time/Frequency – Freq and Substps – Enter the values of Harmonic freq range 1-100, 
Number of sub steps 100, Stepped – Ok. 

 

8. Solve – Current LS – Ok – Solution is done –Close. 

 
POST PROCESSING 

 
10. TimeHist postpro – Variable Viewer – Click “Add” icon – Nodal Solution – DOF 

Solution – Y-Component of displacement – Ok – Enter 2 – Ok. Click “List data” icon 
and view the amplitude list. Click “Graph” icon and view the graph. To get a better 
view of the response, view the log scale of UY. Plotctrls – Style – Graphs – Modify 
axes – Select Y axis scale as Logarithmic – Ok. Plot – Replot – Now we can see the 
betterview. 

 

FOR REPORT GENERATION 

 
11.  File – Report Generator – Choose Append – OK – Image Capture – Ok - Close. 

(Capture allimages) 
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RESULT 

Thus the harmonic analysis of 2D component is done by using the ANSYS 

Software 
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STRESS ANALYSIS OF AN AXI – SYMMETRIC COMPONENT 
 

EX.NO:7 

Date:  
 

Aim: 

To obtain the stress distribution of an axisymmetric component. The model will be that of a 
closed tube made from steel. Point loads will be applied at the centre of the top and bottom plate. 

 

SYSTEM CONFIGURATION 
 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 

PROCEDURE 
 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 
 

PREPROCESSING 

 
1. Utility Menu > Change Job Name > Enter Job Name. Utility 

Menu >File > Change Title > Enter NewTitle. 
 

2. Preference > Structural >OK. 

 
3. Preprocessor > Element type > Add/Edit/ delete > solid 8node 183 >options> 

axisymmetric. 

 
4. Preprocessor > Material Properties > Material Model > Structural > Linear > Elastic> 

Isotropic > EX = 2E5, PRXY =0.3. 
 

5. Preprocessor>Modeling>create>Areas>Rectangle> Bydimensions 
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Rectangle X1 X2 Y1 Y2 

1 0 20 0 5 
2 15 20 0 100 
3 0 20 95 100 

 

6. Preprocessor > Modeling > operate > Booleans > Add > Areas > pick all >Ok. 

 
7. Preprocessor > meshing > mesh tool > size control > Areas > Element edge length =2 

mm > Ok > mesh > Areas > free> pickall. 
 

8. Solution > Analysis Type>NewAnalysis>Static 

 
9. Solution > Define loads > Apply .Structural > displacement > symmetry B.C > onlines. 

(Pick the two edger on the left at X =0) 
 

10. Utility menu > select > Entities > selectall 

 

11. Utility menu > select > Entities > by location > Y = 50>ok. 

 
i. (Select nodes and by location in the scroll down menus. ClickY 

coordinates and type 50 in to the inputbox.) 
 

12. Solution > Define loads > Apply > Structural > Force/Moment > on keypoints 

a. FY > 100 > Pick the top left corner of the area > Ok. 

 
13. Solution > Define Loads > apply > Structural > Force/moment > on key points > FY >- 

100 > Pick the bottom left corner of the area >ok. 
 

14. Solution > Solve > Current LS 

 

15. Utility Menu > select >Entities 

 
16. Select nodes >by location > Y coordinates and type 45, 55 in the min., max. box,as 

shown below and clickok. 
 

17. General postprocessor > List results > Nodal solution > stress > componentsSCOMP. 

 
18. Utilitymenu>plotcontrols>style>Symmetryexpansion>2DAxisymmetric>¾ 

expansion 
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Result: 

Thus the stress distribution of the axi symmetric component is studied 
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THERMAL STRESS ANALYSIS OF A 2D COMPONENT 
 
 

Ex No: 08 

Date:  
 

AIM 

To conduct the thermal c analysis of a 2D component by using ANSYS software. 
 

SYSTEM CONFIGURATION 
 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 
PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 

1. Preference – Thermal - h-Method -Ok. 

 
2. Preprocessor-Elementtype-Add/Edit/Delete–Add–Solid,Quad4node42–Ok 

– Options – plane strsw/thk – Ok – Close. 
 

3. Real constants - Add/Edit/Delete – Add – Ok – THK 100 – Ok –Close. 

 
4 . Material props - Material Models –Structural – Linear – Elastic - Isotropic – EX 2e5, 
PRXY 0.3 – Ok –Thermal expansion – Secant coefficient – Isotropic – ALPX 12e-6 – Ok. 

 
4. Modeling – Create – Areas - Rectangle – by 2 corners – Enter thecoordinate 

values, height, width -Ok. 

 
5. Meshing – Mesh tool – Areas, set – select the object – Ok – Element edge length 10 - Ok – 

Mesh tool- Tri, free - mesh – Select the object–Ok. 
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SOLUTION 

 
7. Solution – Define Loads – Apply – Structural – Displacement - On lines – Select the 

boundary on the object –Ok – Temperature – Uniform Temp – Enter the temp. Value 50 –Ok. 

 

8. Solve – Current LS – Ok – Solution is done –Close. 

 
POST PROCESSING 

 
9. General post proc – Plot results – Contour plot – Nodal solution – Stress – 1st 
principal stress – Ok – Nodal solution – DOF Solution – Displacement vector sum -Ok. 

 

FOR REPORT GENERATION 

 

10. File – Report Generator – Choose Append – OK – Image Capture – Ok –Close 
 

 

 

 
 



 
 

RESULT 

 

Thus the thermal stress analysis of a 2D component is done by using the ANSYS Software. 
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CONDUCTIVE HEAT TRANSFER ANALYSIS OF A 2D COMPONENT 
 

Ex No: 09 

Date : 
 

AIM 

To conduct the conductive heat transfer analysis of a 2D component by using ANSYS 
software. 

 

SYSTEM CONFIGURATION 

 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 
PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 

1. Preference – Thermal - h-Method -Ok. 

 
2. Preprocessor - Element type - Add/Edit/Delete – Add – Solid, Quad 4 node 55 – Ok– 

Close – Options – plane thickness –Ok. 
 

3. Real constants - Add/Edit/Delete – Add – Ok – THK 0.5 – Ok –Close. 

 

4. Material props - Material Models –Thermal – Conductivity – Isotropic – KXX 10 –Ok. 

 
5. Modeling – Create – Areas - Rectangle – by 2 corners – Enter the coordinatevalues, 
width -Ok. 

 
6. Meshing – Mesh tool – Areas, set – select the object – Ok – Element edge length 0.05 - 
Ok – Mesh tool- Tri, free - mesh – Select the object–Ok. 



26 
 

SOLUTION 

 
6. Solution – Define Loads – Apply – Thermal – Temperature - On lines – Select the right and 

left side of the object –Ok – Temp. Value 100 – On lines – select the top and bottom of the 
object – Ok –Temp 500 –Ok. 

 

7. Solve – Current LS – Ok – Solution is done –Close. 

 
 

POST PROCESSING 

 
8. General post proc – Plot results – Contour plot – Nodal solution – DOF solution – Nodal 

Temperature –Ok. 

 
 

FOR REPORT GENERATION 

 

9. File – Report Generator – Choose Append – OK – Image Capture – Ok -Close. 
 
 
 
 
 
 
 

 



27 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RESULT 
 

Thus the conductive heat transfer analysis of a 2D component by using ANSYS is studied. 
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CONVECTIVE HEAT TRANSFER ANALYSIS OF A 2D COMPONENT 
 

ExNo : 10 

Date : 

AIM 

To conduct the convective heat transfer analysis of a 2D component by using ANSYS 
software. 

 

SYSTEM CONFIGURATION 

 

Ram: 2 GB 

Processor: Core 2 Quad / Core 2 Duo 

Operatingsystem: Window XP Service Pack 3 

Software: ANSYS(Version12.0/12.1) 

 

PROCEDURE 

 

The three main steps to be involved are 

1. PreProcessing 

2. Solution 

3. PostProcessing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 
Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 

1. Preference – structural - h-Method -Ok. 

 
2. Preprocessor - Element type - Add/Edit/Delete – Add – Solid, Quad 4 node 55 – Ok– 

Close. 
 

3. Real constants - Add/Edit/Delete – Add –Ok. 

 

3. Material props - Material Models –Thermal – Conductivity – Isotropic – KXX 16 – Ok. 

 
5. Modeling – Create – Key points - In active CS – enter the key point number and X, Y, Z 
location for 8 key points to form the shape as mentioned in the drawing. Lines – lines - 
Straight line - Connect all the key points to form as lines. Areas – Arbitrary -by lines - 
Select all lines - ok. [We can create full object (or) semi-object if it is a symmetricalshape] 
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6. Meshing – Mesh tool – Areas, set – select the object – Ok – Element edge length 0.05 - 
Ok – Mesh tool- Tri,free mesh – Select the object–Ok. 

 

SOLUTION 
 

7. Solution – Define Loads – Apply – Thermal – Temperature - On lines – Select thelines 

–Ok – Temp. Value 300 – Ok – Convection – On lines – select the appropriate line – Ok – 
Enter the values of film coefficient 50, bulk temperature 40 – Ok. 

 

8. Solve – Current LS – Ok – solution is done –Close. 

 

POST PROCESSING: 

10. General post proc – List results – Nodal Solution – DOF Solution – Nodal temperature– 
Ok. 

 

11. Plot results – Contour plot – Nodal solution – DOF solution – Nodal Temperature –Ok. 

 

FOR REPORT GENERATION: 
 

12. File – Report Generator – Choose Append – OK – Image Capture – Ok -Close. 
 
 

 

 

 
 

.CO 
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RESULT 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Thus the convective heat transfer analysis of a 2D component is done by using the 

ANSYS Software 
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EX: 11 

Date:  

Aim : 

Introduction to MATLAB 

 

 

 

To Study the capabilities of MatLab Software. 
 

Introduction 

 
The MATLAB is a high-performance language for technical computing integrates 

computation, visualization, and programming in an easy-to-use environment where problems and 
solutions are expressed in familiar mathematical 

notation. Typical uses include 

• Math andcomputation 

• Algorithmdevelopment 

• Dataacquisition 

• Modeling, simulation, andprototyping 

• Data analysis, exploration, andvisualization 
• Scientific and engineeringgraphics 

• Applicationdevelopment, 

Including graphical user interface building MATLAB is an interactive system whose basic data 
element is an array that does not require dimensioning. It allows you to solve many technical 
computing problems, especially those with matrix and vector formulations, in a fraction of the time 
it would take to write a program in a scalar noninteractive language such as C or FORTRAN. 

 
The name MATLAB stands formatrix laboratory. MATLAB was originally written to provide 
easy access to matrix software developed by the LINPACK and EISPACK projects. Today, 
MATLAB engines incorporate the LAPACK and BLAS libraries, embedding the state of the art in 
software for matrix computation. 
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SIMULINK INTRODUCTION: 
 

Simulink is a graphical extension to MATLAB for modeling and simulation of systems. In 
Simulink, systems are drawn on screen as block diagrams. Many elements of block diagrams are 
available, such as transfer functions, summing junctions, etc., as well as virtual input and output 
devices such as function generators and oscilloscopes. Simulink is integrated with MATLAB and 
data can be easily transferred between the programs. In these tutorials, we will apply Simulink to 
the examples from the MATLAB tutorials to model the systems, build controllers, and simulate the 
systems. Simulink is supported on Unix, Macintosh, and Windows environments; and is included 
in the student version of MATLAB for personalcomputers. 

 
The idea behind these tutorials is that you can view them in one window while running Simulink in 

another window. System model files can be downloaded from the tutorials and opened in Simulink. 

You will modify and extend these system while learning to use Simulink for system modeling, 

control, and simulation for your actual Simulink windows. Most images in these tutorials are not live 

- they simply display what you should see in your own Simulink windows. All Simulink operations 

should be done in your Simulinkwindows. 

 

1. StartingSimulink 

2. ModelFiles 

3. BasicElements 

4. RunningSimulations 

5. BuildingSystems 

 

Starting Simulink 

Simulink is started from the MATLAB command prompt by entering the following command: 

 

>> Simulink 

 
Alternatively, you can hit the Simulink button at the top of the MATLAB window as shown 
below: 
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. Open the modeling window with New then Model from the File menu on the Simulink 
Library Browser as shown above. 

 

This will bring up a new untitiled modeling window shown below 
 
 

 

 
Model Files 

 
In Simulink, a model is a collection of blocks which, in general, represents a system. In addition to 
drawing a model into a blank model window, previously saved model files can be loaded either 
from the File menu or from the MATLAB command prompt. 

 
You can open saved files in Simulink by entering the following command in the MATLAB 
command window. (Alternatively, you can load a file using the Open option in the File menu in 
Simulink, or by hitting Ctrl+O in Simulink.) 

 

>> filename 
The following is an example model window. 
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A new model can be created by selecting New from the File menu in any Simulink window (or by 
hitting Ctrl+N). 

 

Basic Elements 

There are two major classes of items in Simulink: blocks and lines. Blocks are used to generate, 
modify, combine, output, and display signals. Lines are used to transfer signals from one block to 
another. 

Blocks 

 

There are several general classes of blocks: 

 

 Continuous 

 Discontinuous 

 Discrete 

 Look-UpTables 

 MathOperations 

 ModelVerification 

 Model-WideUtilities 

 Ports &Subsystems 

 SignalAttributes 

 SignalRouting 

 Sinks: Used to output or displaysignals 

 Sources: Used to generate various signals 

 User-DefinedFunctions 

 Discrete: Linear, discrete-time system elements (transfer functions, state-space models,etc.) 

 Linear: Linear, continuous-time system elements and connections (summing junctions, gains, 
etc.) 

 Nonlinear: Nonlinear operators (arbitrary functions, saturation, delay,etc.) 

 Connections: Multiplex, Demultiplex, System Macros,etc. 

 
Blocks have zero to several input terminals and zero to several output terminals. Unused input 
terminals are indicated by a small open triangle. Unused output terminals are indicated by a small 
triangular point. The block shown below has an unused input terminal on the left and an unused 
output terminal on the right. 

 

Lines 

 
Lines transmit signals in the direction indicated by the arrow. Lines must always transmit signals 
from the output terminal of one block to the input terminal of another block. One exception to this 
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is a line can tap off of another line, splitting the signal to each of two destination blocks, as shown 
below. 

 
 

Lines can never inject a signal into another line; lines must be combined through the use of a block 
such as a summing junction. 
A signal can be either a scalar signal or a vector signal. For Single-Input, Single-Output systems, 
scalar signals are generally used. For Multi-Input, Multi-Output systems, vector signals are often 
used, consisting of two or more scalar signals. The lines used to transmit scalar and vector signals 
are identical. The type of signal carried by a line is determined by the blocks on either end of the 
line. 

 
Simple Example 

 

The simple model (from the model filessection) consists of three blocks: Step, Transfer Fcn, and 
Scope. The Step is a source block from which a step input signal originates. This signal is 
transferred through the line in the direction indicated by the arrow to the Transfer Function linear 
block. The Transfer Function modifies its input signal and outputs a new signal on a line to the 
Scope. The Scope is a sink block used to display a signal much like an oscilloscope. 
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There are many more types of blocks available in Simulink, some of which will be discussed later. 
Right now, we will examine just the three we have used in the simple model. 

 

 

Running Simulations 

To run a simulation, we will work with the following model file: 

 

simple2.mdl 

 
Download and open this file in Simulink following the previous instructions for this file. You 
should see the following model window. 

 
 

 
 

Before running a simulation of this system, first open the scope window by double-clicking 
on the scope block. Then, to start the simulation, either select Start from the Simulation menu (as 
shown below) or hit Ctrl-T in the model window. 
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The simulation should run very quickly and the scope window will appear as shown below. If it 
doesn't, just double click on the block labeled "scope." 

 
 

 

Note that the simulation output (shown in yellow) is at a very low level relative to the axes of the 
scope. To fix this, hit the autoscale button (binoculars), which will rescale the axes as shown below. 
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Note that the step response does not begin until t=1. This can be changed by double- 
clicking on the "step" block. Now, we will change the parameters of the system and simulate the 
system again. Double-click on the "Transfer Fcn" block in the model window and change the 
denominator to Re-run the simulation (hit Ctrl-T) and you should see what appears as a flat line in 
the scope window. Hit the autoscale button, and you should see the following in the scope window. 

 

 
Notice that the autoscale button only changes the vertical axis. Since the new transfer 

function has a very fast response, it compressed into a very narrow part of the scope window. This 
is not really a problem with the scope, but with the simulation itself. Simulink simulated the system 
for a full ten seconds even though the system had reached steady state shortly after onesecond. 

 
To correct this, you need to change the parameters of the simulation itself. In the model 

window, select Parameters from the Simulation menu. You will see the following dialogbox. 
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There are many simulation parameter options; we will only be concerned with the start and 
stop times, which tell Simulink over what time period to perform the simulation. Change Start time 
from 0.0 to 0.8 (since the step doesn't occur until t=1.0. Change Stop time from 10.0 to 2.0, which 
should be only shortly after the system settles. Close the dialog box and rerun the simulation. 

 
After hitting the autoscale button, the scope window should provide a much better display 

of the step response as shown below. 
 

 

 

 
RESULT 

 

Thus the features of MATLAB are studied



 

  EX.NO:    FORCE AND STRESS ANALYSIS USING LINK ELEMENTS       IN TRUSSES 

AND CABLES 
 

    AIM : 

To conduct the force and stress analysis using link elements in trusses and cables 

using ANSYS software. 

 
SYSTEM CONFIGURATION 

Ram : 2 GB 

Processor : Core 2 

Quad / Core 2 Duo Operating 

system: Window 

XP Service Pack 3 Software :

 ANSYS 

(Version12.0/12.1) 

 
PROCEDURE: 

The three main steps to be involved are 

1. Pre Processing 

2. Solution 

3. Post Processing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product 

Launcher – Set the Working Directory as E Drive, User - Job Name as 

Roll No., Ex. No. – Click Run. 

PREPROCESSING 

 
1. File – clear and start new – do not read file – ok – yes. 

 
2. Ansys Main Menu – Preferences select – STRUCTURAL - ok 

 
3. Element type – Add/Edit/Delete – Add – Link – 2D spar 1 – ok – close. 

 

4. Real constants – Add – ok – real constant set no – 1 – c/s area – 0.1 – ok – 

close. 

 

5. Material Properties – material models – Structural – Linear – Elastic 

– Isotropic – EX – 210e9 – ok – close. 

 
6. Modeling – Create – Nodes – In Active CS – Apply (first node is created) – 

x,y,z location in CS– 4 (x value w.r.t first node) – apply (second node is 

created) – x,y,z location in CS – 4, 3 (x, y value w.r.t first node) – apply 

(third node is created) – 0, 3 (x, y value w.r.t first node) – ok (forth node is 

created). 

 
7. Create – Elements – Elem Attributes – Material number – 1 – Real constant set 

number – 1 – ok Auto numbered – Thru Nodes – pick 1 & 2 – apply – pick 2 

& 3 – apply – pick 3 & 1 – apply – pick 3 & 4 – ok (elements are created 

through nodes). 

 

 

 
 



 
 

 



 
 

 

 

 
 

8. Loads – Define loads – apply – Structural – Displacement – on Nodes – pick node 1 & 4 – 

apply– DOFs to be constrained – All DOF – ok – on Nodes – pick node 2 – apply – DOFs to be 

constrained – UY – ok. 

 
9. Loads – Define loads – apply – Structural – Force/Moment – on Nodes- pick node 2 – apply – 

direction of For/Mom – FX – Force/Moment value – 2000 (+ve value) – ok – Structural – 

Force/Moment – on Nodes- pick node 3 – apply – direction of For/Mom – FY – Force/Moment 

value – -2500 (-ve value) – ok. 

 
SOLUTION 

 

10. Solve – current LS – ok (Solution is done is displayed) – close. 

GENERAL POST PROCESSOR 

11. Element table – Define table – Add – ‘Results data item’ – By Sequence num – LS – LS1 – ok. 

 

12. Plot Results – Deformed Shape – def+undeformed – ok. Plot results – contour plot – Line 

Element Results – Elem table item at node I – LS1 – Elem table item at node J – LS1 – ok 

(Line Stress diagram will be displayed). 

 
13. Plot results – contour plot – Nodal solution – DOF solution – displacement vector sum – ok. 

List Results – reaction solution – items to be listed – All items – ok (reaction forces will be 

displayed with the node numbers). List Results – Nodal loads – items to be listed – All items – 

ok (Nodal loads will be displayed with the node numbers). 

 
14. PlotCtrls – Animate – Deformed shape – def+undeformed-ok 

 

INFERENCE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

RESULT 
 

Thus the force and stress analysis using link elements in trusses and cables is done by using 

the ANSYS Software. 



 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

Rectangular c/s area of 0.2 m * 0.3 m, Young’s modulus of 210 GPa, Poisson’s ratio 0.27. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Rectangular c/s area of 0.2 m * 0.3 m, Young’s modulus of 210 GPa, Poisson’s ratio 0.27. 



 

 
 
 
 
 
 
 

                                 EX.NO:            2D-THERMAL STATIC ANALYSIS OF CHIMNEY 

 

 
AIM : 

To analyse the temperature distribution of chimney. 

 
SYSTEM CONFIGURATION 

 
Ram : 2 GB 

Processor : Core 2 Quad / Core 2 Duo 

Operating system: Window XP Service Pack 3 

Software : ANSYS (Version12.0/12.1) 

 
PROCEDURE: 

The three main steps to be involved are 

1. Pre Processing 

2. Solution 

3. Post Processing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 

Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 
1. Preference → tick → thermal → select ‘h‘method → ok 

 
2. Title: Utility menu → file change title → chimney → ok 

 
3. Utility menu → plot → replot. 

 
4. Elements: Main menu → preprocessor → element type → add/edit/delete → add → thermal 

mass → solid → quad. 4node 55 → ok 

 
5. Material Properties: Main menu → preprocessor→ Material props → material models → material 

model 1 → thermal → conductivity → isotropic → enter KXX1 = 0.037 → ok 

 
6. Material→ new model → material ID 2→ material model 2 → thermal → conductivity → 

isotropic → enter KXX2 = 0.012 → ok. 

 
7. Modeling: Main menu → preprocessor → modeling → Create → Areas → Rectangle → by 

center and corner → enter 0,0,26,26 → ok. 

 

 
 
 



 
 

 

 

 

8. Main menu → preprocessor → Modeling → Create → Areas → Rectangle → By center and 

corner → enter 0,0,13,13 → ok. 

 
9. Main menu → preprocessor → Modeling → Operate → boolean → subtract → area → select 

base area → apply → select area to be subtracted → ok. 

 
10. Main menu → preprocessor → Modeling → Create → Areas → Rectangle → By center and 

corner → enter 0,0,13,13 → ok. 

 
11. Main menu → preprocessor → Modeling → Create → Areas → Rectangle → By center and 

corner → enter 0,0,12,12 → ok. 

 
12. Main menu → preprocessor → Modeling → Operate → boolean → subtract → area → select 

base area → apply → select area to be subtracted → ok. 

 
13. Main menu → preprocessor → Modeling → Operate → boolean → glue → area → pick all → 

ok. 

 
14. Utility menu → plot cntrl → hard copy → to file → jpeg → save to: chimney. jpg → ok 

 

15. Main menu → preprocessor → Meshing → size cntrl → manual size → global → size → enter 

SIZE as 0.25 → ok 

. 

16. Main menu → preprocessor → meshing → mesh attributes → difficult attributes → select 

element 1; material 1→ ok. 

 
17. Main menu → preprocessor → Meshing → mesh tool → mesh → pick brick area (3) → ok. 

 
18. Main menu → preprocessor → Meshing → mesh attributes → difficult attributes → select 

element 1 ; material 2→ ok. 

 
19. Main menu → preprocessor → Meshing → mesh tool → mesh → pick concrete area (1) → ok 

 
20. Utility menu → plot cntrl → hard copy → to file → jpeg → save to: chimney mesh. jpg → ok 

 
21. Boundary conditions and Loads 

 
22. Main menu → solution → define loads → apply → thermal → convection → on lines → select 

by mouse; all outer lines (1, 2, 3, 4) → ok → enter ValI 0.012 → enter Val2I 10 → ok. 

 
23. Main menu → solution → define loads → apply → thermal → convection → on lines → select 

by mouse; all inner lines (13, 14,15, 16) → ok → enter ValI 0.037 → enter Val2I 140 → ok. 

 

 



 

 

 

 

24.  Utility menu → plot controls → hard copy → to file → jpeg → save to : 

chimney load.jpg → ok 

 

SOLUTION 
 

25. Solve – Current LS – Ok – Solution is done – Close. 

 
POST PROCESSING 

 

26.General post proc – Plot results – Contour plot – Nodal solution – Stress – 1st principal stress 

– Ok – Nodal solution – DOF Solution – Displacement vector sum - Ok. 

 
FOR REPORT GENERATION 

27. File – Report Generator – Choose Append – OK – Image Capture – Ok - Close. 

 

INFERENCE 

 

 

 
 

 

 

 
 

 

 
 

 

 
 

 RESULT: 

Thus the temperature distribution of chimney is done by using the ANSYS Software. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

                         EX.NO:                MODAL ANALYSIS OF BEAMS 
 

 
 
 

AIM : 

 
To conduct the Modal Analysis of beams by using ANSYS software. 

SYSTEM CONFIGURATION 

 
Ram : 2 GB 

Processor : Core 2 Quad / Core 2 Duo 

Operating system: Window XP Service Pack 3 

Software : ANSYS (Version12.0/12.1) 

 
PROCEDURE: 

 
The three main steps to be involved are 

1. Pre Processing 

2. Solution 

3. Post Processing 

Start - All Programs – ANSYS 12.0/12.1 - Mechanical APDL Product Launcher – Set the 

Working Directory as E Drive, User - Job Name as Roll No., Ex. No. – Click Run. 

 

PREPROCESSING 

 
1. Preference – structural - h-Method - Ok. 

 
2. Element type – Add/Edit/Delete – Add – BEAM – 2D elastic 3 – ok- close. 

 

3. Real constants – Add – ok – real constant set no – 1 – c/s area – 0.01*0.01 moment of inertia 

– 0.01*0.01**3/12 – total beam height – 0.01 – ok. 

 
4. Material Properties – material models – Structural – Linear – Elastic – Isotropic – EX – 

200e9– PRXY – 0.27 – Density – 7800 – ok – close. 

 
5. Modeling – Create – Keypoints – in Active CS – x,y,z locations – 0,0 – apply – x,y,z locations 

– 1,0 – ok (Keypoints created). Create – Lines – lines – in Active Coord – pick keypoints 1 and 2 – 

ok. 

 
6. Meshing – Size Cntrls – ManualSize – Lines – All Lines – element edge length – 0.1 – ok. 

Mesh – Lines – Pick All – ok. 
  

 

 

 

 

 

 

 



 

SOLUTION 
 

7. Solution – Analysis Type – New Analysis – Modal – ok. 

 
8. Solution – Analysis Type – Subspace – Analysis options – no of modes to extract – 5 – no of 

modes to expand – 5 – ok – (use default values) – ok. 

 
9. Solution – Define Loads – Apply – Structural – Displacement – On Keypoints – Pick first 

keypoint – apply – DOFs to be constrained – ALL DOF – ok. Solve – current LS – ok 

(Solution is done is displayed) – close. 

 
10 Solve – Current LS – Ok – solution is done – Close. 

 
GENERAL POST PROCESSOR: 

 

11. Read Results – First Set. Plot Results – Deformed Shape – def+undeformed – ok. 

PlotCtrls – Animate – Deformed shape – def+undeformed-ok. 

 
12. Read Results – Next Set. Plot Results – Deformed Shape – def+undeformed – ok. PlotCtrls 

– Animate – Deformed shape – def+undeformed-ok. 

INFERENCE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESULT: 

Thus the Modal Analysis beams is done by using the ANSYS Software. 

 

 

 

 

 

 

 

 

 



 

 

 
 

 

 

 

                  EX.NO:  SIMULATION OF AN ACCUMULATOR 

 

 

 

AIM : 

 
To perform simulation of an accumulator using matlab. 

 
PROBLEM STATEMENT 

 
An accumulator is loaded with 400KN weight. The diameter of ram is 300mm and has a stroke 

length of 6m. if friction is taken as 5%, it takes two minutes to fall through full stroke. Find the total work 

supplied and power delivered using matlab the flow rate of the fluid is 0.0075m3/sec while accumulator 

descends with stated velocity. Take density of fluid as 1000N/m3. 

 
PROGRAM: 

 
#include<stdio.h> 

#include<conio.h> 

#include<stdib.h> 

#include<math.h> int main() 

{ 

Float sl=0.0,w=0.0,d=0.0,f=0.0,a=0,0,p=0.0,h=0.0,ds=0.0,wd=0.0,fl=0.0; 

Float ls=0.0,t=0.0,nl=0.0,ws=0.0,tw=0,0,pd=0.0,ns=0.0,l=0.0; 

Printf(“\nEnter stroke length<m>”); 

Scanf(“%f”,&sl); 

Printf(“\nEnter time taken for completion of stroke<s>”); 

Scanf(“%f”,&t); 

Printf(“\nEnter the piston force<kN>”); 

Scanf(“%f”,&w); 

Printf(“\nEnter friction value<%>”); 

Scanf(“%f”,&fl); 

Printf(“\nEnter the diameter of ram<m>”); 

Scanf(“%f”,&d); 

Printf(“\nEnter the flow rate<m3/s>”); 



 
 

 

 

 
 

Scanf(“%f”,&ls); 

f=fl/100; 

a=(3.14/4)*(d*d); nl=w*(l-f); 

wd=nl*(sl/t); p=(nl/a); h=p/(1000*9.81); ws=(9810*ls)*h; tw=wd+ws; 

printf(“\nTotal work supplied to the hydraulic machine in kNm=%f”,tw); pd=tw/t; 

printf(“\nPower delivered in kw=%f”,pd); getch(); 

} 

 

 
INPUT PARAMETERS 

Stroke length 

Time taken for completion of a stroke 

Piston force friction value 

Diameter of ram flow rate 

 

 
OUTPUT PARAMETERS 

Total work supplied to the hydraulic machine  

Power delivered  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
RESULT 

Thus simulation of an accumulator has been done using matlab. 



 

 

 

 

 

 

                       EX.NO:        SIMULATION OF CAM AND FOLLOWER 

 

 

AIM : 

 
To perform simulation of cam and follower using matlab. 

 
PROBLEM STATEMENT 

 
A cam is to operate a flat faced follower having uniform acceleration and deceleration. The least 

radius of cam is 50mm. During decent the deceleration period is half of the acceleration period. The ascent 

lift is 37.5 mm. The ascent is for one fourth period, dwell for one third and remaining is descent. The cam 

rotates at 600rpm. Simulate using matlab to determine the maximum velocity during ascent and descent. 

 
PROGRAM: 

 
#include<stdio.h> 

#include<conio.h> 

#include<stdib.h> 

int main() 

{ 

int a1, a2; 

Float n,w,s1,s,outr,inr,vo,ao,vr,ar; 

Printf(“\nEnter speed of rotation<rpm>”); 

Scanf(“%f”,&n); w=(2*3.14*n)/60; 

Printf(“\nEnter the cam lift <mm>”); 

Scanf(“%f”,&s1); s=s1/1000; 

Printf(“\nEnter cam ascent period<degrees>”); 

Scanf(“%f”,&out); 

Printf(“\nEnter cam descent period<degrees>”); 

Scanf(“%f”,&in); 

Outr=(3.14/180)*out; 

Inr=(3.14/180)*in; 

Vo=(2*w*s)/out; 

 

 



 

 
 
  



 
 

 

 

 
 

ao=(4*w*w*s)/(outr*outr); 

vr=(2*w*s)/inr; 

ar=(4*w*w*s)/(inr*inr); 

Printf(“\nAngular velocity = %f<rad/s>”,w); 

Printf(“\nOUTWARD STROKE”); 

Printf(“\nMaximum velocity =%f<m/s>”,vo); 

Printf(“\nMaximum acceleration =%f<m/s^2>”,ao); 

Printf(“\nRETURN STROKE”); 

Printf(“\nMaximum velocity =%f<m/s>”,vr); 

Printf(“\nMaximum acceleration =%f<m/s^2>”,ar); 

getch() 

} 

 

 
INPUT PARAMETERS 

Speed of rotation 

Cam lift 

Cam ascent period 

Cam descent period 

OUTPUT PARAMETERS 

Angular velocity = 

OUTWARD STROKE 

Maximum velocity = 

Maximum acceleration = 

RETURN STROKE 

Maximum velocity = 

Maximum acceleration = 

 

 

 
RESULT 

Thus simulation of an cam and follower has been done using Matlab. 



 

 

 
 

 
 

 
 

 

EX.NO: DESIGN OF SLIDER CRANK MECHANISM USING ADAMS 

 

 

 

 

AIM : 

To design and develop slider crank mechanism using Adams 

SYSTEM CONFIGURATION 

 
Ram : 2 GB 

Processor : Core 2 Quad / Core 2 Duo 

Operating system: Window XP Service Pack 3 

Software : Adams View, Adams Post Processor 

 

PROCEDURE: 

Step 1. Creating the Model 

a. Start Adams/View 

b. Create a new model. 

c. Resize the working grid. 

d. Open Coordinate Window 

e. Create crank part from point (60, 0, 0) to (150, 0, 0) 

f. Rename. slider crank. crank 

Step 2. Creating Revolution 

a. Select Rigid Body: Revolution 

b. Click the points 

c. Right-click too close 

d. Rename. slider crank. cylinder. 

Step 3. Creating Joints 

a. Select Rigid body: Cylinder 

b. Create piston part. Rename. slider crank. piston 

d. Create revolute joints between crank and ground 

e. Create spherical joint between cylinder and ground 

f. Create translational joint between piston and cylinder. 

g. Create Hooke joint between crank and piston 

h. Add Rotational joint motion to revolute joint with function = -30deg - 60 * time. 

Step 4. Create Point-to-Point Measure 

a. From Design Exploration ribbon, select Point to-Point Measure 

b. Select Displacement as Characteristic 

c. Select Global as Component. 

d. Select the Marker at the left end of cylinder and the Marker at the left end of crank 

e. Rename it as MEA_PT2PT_R 

Step 5. Create Point Measure 

a. Under the piston tree in the Model Browser, nightsticks and select Measure 

b. Select Translational Velocity and select Component. 

c. Enter cylinder.cm as Represent coordinates 

 

 



 

 



 
 

 



 
 

 

 

 
 

d. Select any Marker belongs to the ground as DO time derivatives in. 

e. Repeat the above steps to create a translational acceleration 

 

Step 6. Create Angle about Axis Measure 

a. In the Bodies tree, right-click the spherical joint between cylinder and the ground 

b. Select info and remember the name of I Marker and Marker. 

c. Close the info window. 

d. Select Function Measure 

e. Select Angle about Z under Displacement and enter the marker name in Step b. 

f. Select angle as units 

 

Step 7. Testing the Model 

a. From Simulation ribbon, select Run an Interactive Simulation 

b. Set End Time to 0.01 and Step Size to 0.001, and then click Start 

c. Click Plotting 

d. Use the Plot tracking tool 

e. Follow the plot curve. Find the size measurement at X= 0.0 

 

Theory: 

The Slider-crank mechanism is used to transform rotational motion into translational motion by 

means of a rotating driving beam, a connection rod and a sliding body. In the present example, a 

flexible body is used for the connection rod. The sliding mass is not allowed to rotate and three 

revolute joints are used to connect the bodies. While each body has six degrees of freedom in 

space, the kinematical conditions lead to one degree of freedom for the whole system. 

 

 
A slider crank mechanism converts circular motion of the crank into linear motion of the slider. In 

order for the crank to rotate fully the condition L> R+E must be satisfied where R is the crank 

length, L is the length of the link connecting crank and slider and E is the offset of slider. A slider 

crank is a RRRP type of mechanism i.e. It has three revolute joints and 1 prismatic joint. The total 

distance covered by the slider between its two extreme positions is called the path length. 

Kinematic inversion of slier crank mechanisms produces ordinary a white work quick return 

mechanism 

 

 

 

 

 

 

 
 

RESULT : 

Slider crank mechanism is designed using ADAMS 
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